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WARNING – when using electric products, basic precautions should be followed, including the following: 

 

Read all of the safety and installations instructions and explanation of graphic symbols before using the 

product. 

 

1  Do not use this apparatus near water. 

2.  Clean only with dry cloth. 

3.  Do not block any ventilation openings. Install in 

accordance with the manufacturer's instructions. 

4. Do not install near any heat sources such as 

radiators, heat registers, stoves, or other 

apparatus (including amplifiers) that produce 

heat. 

5. Do not defeat the safety purpose of the polarized 

or grounding-110 to 125V type plug according to 

UL 817 and CSA C22.2 no. 42. A polarized plug 

has two blades with one wider than the other. A 

grounding type plug has two blades and a third 

grounding prong. The wide blade or the third 

prong are provided for your safety. If the 

provided plug does not fit into your outlet, 

consult an electrician for replacement of the 

obsolete outlet. 

 

 

6  Protect the power cord from being walked on or 

pinched particularly at plugs, convenience 

receptacles, and the point where they exit from 

the apparatus.  

7  Only use attachments/accessories specified by 

the manufacturer. 

8. Use only with the cart, stand, tripod, bracket, or 

table specified by the manufacturer, or sold with 

the apparatus. When a cart is used, use caution 

when moving the cart/apparatus combination to 

avoid injury from tip-over. 

9 Unplug this apparatus during lightning storms or 

when unused for long periods of time. 

10 Refer all servicing to qualified service personnel. 

Servicing is required when the apparatus has 

been damaged in any way, such as power-supply 

cord or plug is damaged, liquid has been spilled 

or objects have fallen into the apparatus, the 

apparatus has been exposed to rain or moisture, 

does not operate normally, or has been dropped. 

 

DANGER  

Improper connection of the equipment-grounding can result in a risk of electric shock. Do not modify the 

plug provided with the product – if it will not fit the outlet have a proper outlet installed by a qualified 

electrician. Do not use an adapter which defeats the function of the equipment-grounding conductor. If 

you are in doubt as to whether the product is properly grounded, check with a qualified serviceman or 

electrician. 

 

 

IMPORTANT SAFETY INSTRUCTIONS  

READ AND KEEP THESE INSTRUCTIONS 
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The product must be grounded. If it should malfunction or breakdown, grounding provides a path of least 

resistance for electric current to reduce the risk of electric shock. This product is equipped with a power 

supply cord having an equipment-grounding  conductor and a grounding plug. The plug must be plugged 

into an appropriate outlet which is properly installed and grounded in accordance with all local codes and 

ordinances.  

 

WARNING 

• This product, either alone or in combination with an amplifier and speakers or headphones, may be 

capable of producing sound levels that could cause permanent hearing loss. Do not operate at a high 

volume level or at a level that is uncomfortable. If you experience any hearing loss or ringing in the 

ears, you should consult an audiologist. 

• The product should be located so that its location or position does not interfere with its proper 

ventilation. 

• The power-supply cord of the product should be unplugged from the outlet when left unused for a 

long period of time. When unplugging the power supply, do not pull on the cord, but grasp it by the 

plug. 

• Care should be taken so that objects do not fall and liquids are not spilled into the enclosure through 

openings. 

 

SERVICE 

• Do not attempt to service the product beyond that described in the user maintenance instructions. All 

other servicing should be referred to qualified service personnel. 

• The product should be serviced by qualified service personnel when:  

1.  The power supply cord or plug has been damaged, or 

2.  Objects have fallen, or liquid has spilled into the product, or 

3.  The product has been exposed to rain, or 

4.  The product does not appear to be operating normally or exhibits a marked change in 

performance, or 

5. The product has been dropped, or the enclosure damaged. 

 

 

WARNING – Hazardous moving parts inside the AX32. Keep fingers and other body parts away. 
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Introduction 

Congratulations, and thank you for purchasing the DAD AX32 Converter System. AX32 is an extremely 
capable multi channel audio converter and microphone preamplifier for independent simultaneous 
analogue-to-digital (A/D) and digital-to-analogue (D/A) conversion as well as digital-to-digital format 
conversion and signal routing. AX32 can interface a total 48 analogue input and output channels 
depending on the configuration of the unit, and has fixed installed 8 stereo AES3 inputs and outputs (16 I/O 
channels), dual DigiLink connection for 64 input and output channels interface to Pro Tools HDX™ , one 
coaxial 64 channel MADI input and output connection, and optionally by installing a mini I/O module 
additionally two optical 64 channel MADI input and output connectors via “Small form-factor pluggable” 
(SFP) transceiver modules. Further more 64 input and output channels of Ethernet IP audio powered by 
Dante™  is supported by installing the internal IP audio option. As standard the basic chassis is equipped with 
one fixed power supply. For redundant power operation two power supplies can be installed. 

Before you start 

This user manual provides basic information about the operation and use of the AX32.  

For more detailed information related to the installation of the AX32 please refer to the installation 
guide on the DAD website, www.digitalaudio.dk. 

 

Overview of the AX32 

The AX32 features are quite comprehensive and are listed below: 

Key features 

• 8 to 48 analogue channels with 8 channels on a card. 

• 8 ch. Line input AD card, 8 ch. Mic/Line input AD card and 8 ch. Line output DA card with output 
level control. 

• Microphone preamplifier with relay based gain circuit. 

• Digital router and format converter between all analogue and digital inputs and outputs. 

• Sample rates 44.1 kHz up-to 384 kHz as well as DSD64/DSD 128 with high precision internal clock 
and PLL. 

• Synchronisation via Word Clock, AES11, Video, and all digital audio inputs. 

• Sample rate can be adapted to the setting of an external device. 

• 8 AES3 interfaces with 16 I/O channels 

• MADI coax interface with 64 I/O channels. 

• 64 channel interface for Pro Tools™   with two DigiLink ports, configurable as Primary or 
Primary/expansion ports. 

• Ethernet IP audio interface for 64 I/O channels using Dante™   with configurable redundant 
network. 

• Compliant with the Dante™   Controller and Dante™   Virtual Sound Card. 

• Some settings can be controlled on the front panel. 

• Operation via DADman control software for Windows and OSX. 

• All settings are controlled via the Ethernet interface. 

• Ultra low noise internal fan with speed adaptation to the temperature. 
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General Description 

The AX32 Converter System is a modular unit with a basic digital I/O and processing card. The chassis has 
eight card slots where up to six 8 channel analogue input or output cards can be installed. 

The chassis can be fitted with one or two power supplies. One power supply is sufficient when using a 
maximum of 5 cards. In that situation, it is possible to have a second power supply installed as a redundant 
power supply. When 6 cards are installed, two power supplies must be installed in order to keep the 
temperature in the power supply at a reasonable level. An AX32 with 6 cards can operate on one power 
supply only, so the AX32 will not go down if one of the power supplies fail. However it is not recommended 
to leave the AX32 operating like this for several days as the lifetime of the remaining power supply may be 
reduced considerably. 

AX32 has a slot for an optional I/O mini module. The module can be a dual optical MADI I/O interface using 
“Small form-factor pluggable” (SFP) transceiver modules, providing 2 x 64 optical MADI channels. 

The IP audio option for AX32 is established by installing a Dante™   Brooklyn II module internally in the unit. 
The IP audio will interface to the Ethernet connector via an internal Ethernet switch on the basic digital I/O 
and processing card. The switch operates as a bridge between the two RJ 45 Ethernet connectors on the 
rear panel and the internal controller and the Dante™  Brooklyn II module. In normal operation both 
connectors can be used for connecting to Ethernet, and as switch to expand the connection to other units. 
When the IP audio option is operating in redundant mode the two connectors have redundant IP audio 
streams. In this case the control of the unit is made via network connector 1. 

AX32 is a remote controlled unit. The control interface is the Ethernet connector and the DADman software 
controls the units via Ethernet. Some front panel control of the units is also possible. 

In addition to the AD/DA conversion and digital I/O functionality, AX32 provides a very powerful router 
matrix functionality as well. All input signals can be patched to one or more output interfaces on a mono 
channel basis. So in fact the AX32 is also a digital patch bay. 

Figure 1 shows an overall block diagram for the AX32 Converter System. 
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Figure 1, AX32 block diagram 
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Clock and synchronisation system 

The clock system of AX32 supports various internal and external clock modes. AX32 has a precise and very 
high quality internal sample clock generator, which also can be clocked also from an external clock signal by 
means of a very accurate Digital Phase Locked Loop (DPLL) system. 

 

The AX32 clock system has to 
be set to the correct sample 
rate with which the units 
should operate. This is the case 
both when operating with the 
internal sample clock generator 
as master clock or when 
synchronised to an external 
clock source. The Sample rates 
supported is either based on 
44.1 or 48 kHz sampling. An 
external clock must always 
have a correct base rate in 
relation to the sample rate 
used. 

 

 Figure 2, AX32 Sample clock circuit 

The sample rate with which the AX32 should operate can be set manually via DADman or the front display, 
or the sample rate can be adapted to an external digital device e.g. a Pro Tools DAW system. When using 
the IP Audio interface powered by Dante™  the sample rate of the Dante™  I/O node to the IP Audio network 
can be set to follow the sample rate of the AX32. When more AX32 units are operating in the same set up 
or IP Audio network they must be set to the same sample rate. 

For information on how to configure the synchronisation and sample rates, please refer to the 
Operation section of this manual. 

Router functions and principle 

The AX32 Converter System includes a 
very flexible router matrix. All input 
signals can be patched to one or more 
output interfaces on a mono channel 
basis. 

In order to set up the correct signal flow 
in the  AX32, the correct connections 
have to be set in the matrix. This is done 
via the DADman user interface. Any one 
of the analogue or digital inputs 
installed in the AX32 can be patched to 
any analogue or digital output or split 
into multiple outputs. 

This means that the e.g. 16 analogue 
input channels can be patched to the 
Pro Tools output and the Pro Tools input 
can be patched to a MADI output. And 
at te same time two channels can be 
patched to the  analogue output.  

Furthermore, e.g. 8 AES3 channels can 
at the same time be patched to the 
optical MADI output. 

 
 

                                          Figure 3, AX32 router matrix 
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It is essential that all digital signals connected to the AX32 are synchronised to the same basic clock signal. 

In order to patch IP Audio channels between different devices, the Dante Controller software tool from 
Audinate has to be used. 

For details on how to configure the routing matrix, please refer to the section Operation in this 
manual. 

Operation 

The AX32 is controlled via the DADman software and some simple control and status viewing can be made 
via the front panel of the unit. The DADman control program interfaces to the unit via one of the rear panel 
Ethernet connectors. On the front panel two rows of LED indicators are available for indication of the AD 
and DA signal level, an LCD display is available for simple control and for showing various settings of the 
AX32. 4 buttons are available for accessing the settings shown in the display. 

 

 

Figure 4, Front panel layout 

Front panel layout 

 

1. 16 LED indicators for signal level indication of the analogue AD input. 

2. 16 LED indicators for signal level indication of the analogue DA output. 

3. 4 buttons for operating the status display. 

4. Status display. 

 

Front panel LED’s 

AX32 has two rows of 16 LED indicators on the front panel showing the signal status for the AD inputs and 
DA outputs. 

 

 

AD  Signal of AD channel 1-16. Yellow indicates 
OL/Signal signal input above -42dB FS, and red indicates 
 signal above -0.5 dB FS. 

DA  Signal of DA channel 1-16. Yellow indicates 
Signal/carrier signal above -42dB FS. Green indicates signal 
 below -42dB FS and a valid digital input 
 source/carrier. 
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Front panel status display 

The display of the AX32 has four rows for displaying information and four knobs for entering and scrolling 
information. The display can show more pages and each page can consist of rows where settings can be 
changed, and with rows for just showing status information. The display functions for the basic page are 
described below. More pages are available depending on the firmware version of the AX32. For more 
information on these pages please refer to the user manual. 

 

             

             

 

Operating buttons 

Setting Pushing the button scrolls trough the settings 
rows. The > curser marks the selected 
row/function. 

Up Pushing the button scrolls up the value/ setting 
of the selected function. 

Down Pushing the button scrolls down the 
value/setting of the selected function. 

Page Pushing the button scrolls trough the available 
display pages. 

 

 

 

Basic display page – sample rate, synchronization, ID 
and alarms 

Sample Rate Shows sample rate of the AX32. If an asterisk 
* is shown the sample rate is controlled via an 
external digital audio interface. 

SRate Adapt Shows which external digital audio interface 
that controls the sample rate or shows 
“Intern” for internal sample rate control. 

Sync Source Shows the external synchronisation clock 
source or shows “Intern” when the AX32 uses 
the internal clock. 

Unit ID /Name Shows unit ID number and unit name. This is 
set via DADman. 

Alarm/status Shows alarm status: 

 Sync OK = Clock sync is OK 
 SyncErr = Clock sync failure 
 TempErr = temperature inside AX32 is above 

60ºC / 140ºF. Check that the AX32 is installed 
in accordance with the instructions. 

 Fan Err = One of the two fans is not working 
correctly. Contact a DAD representative or the 
factory. 

 CardErr = Fault in one of the A/D or D/A 
cards. Contact a DAD representative or the 
factory. 

 Psu Err = Power supply failure. Contact a DAD 
representative or the factory. 
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Reconfig button 

The “Reconfig” button on the back of the AX32 should not be used during normal installation. It is 
generally intended as an ultimate recovery function in case something goes wrong during programming of 
IP addresses or a software upgrade, e.g. an unintended power loss. It allows the AX32 to start in various 
“basic” modes so it can be restored without having to be returned to the factory. 

The “Reconfig” button is accessed via a hole in the rear panel using a pen or a similar pointed item. A green 
LED is visible through the hole. When the “Reconfig” button is activated, the LED will light up indicating the 
two reconfig modes of the AX32. 

 

Recovery mode   

 

“Reconfig”  

pushed while the 
unit is powering 
up 

Green LED 
turns ON 

The AX32 enters a recovery mode. In this mode 

only a basic boot software is operative in the 
unit, and new software can be downloaded via 
the DADman software. This mode is used if the 
software in the AX32 for some reason is not 
operative or broken. 

The IP address settings of the unit are the last 
setting used in the unit. 

 

 “Reconfig”  

short push  
while the unit is 
in reconfig mode 
and Green LED is 
on 

Green LED 
turns OFF 

The AX32 remains in reconfig mode as described 
above. 

The IP address settings of the unit is however set 
to DHCP. In case there is no DHCP server on the 
network, the AX32 will default to IP address 
10.0.7.20 / 255.255.0.0 after approx. 2 minutes. 

 

 

The selection of either of the two recovery modes are fixed after selection. The AX32 will start with a basic 
boot software and IP configuration. The AX32 will not be operational until a proper firmware has been 
downloaded via the DADman software and it has been restarted. By enabling recovery mode with default IP 
address and network configuration the unit can always be identified on a network via the default setup. 

Note that the IP address referred to is the IP address of the controller/management 
interface of the unit. This is not the IP address of the IP audio interface if a such is 
installed. This IP address can not be accessed in recovery or restore defaults mode. 

 

Restore defaults   

 

Push “Reconfig”  
for 10 sec. while 
the unit is in 
normal operation. 

Release 
“Reconfig”  
button 

Green LED 
OFF 

 

The AX32 enters a restore default mode. In this 

mode all setting of the unit is initialized to the 
factory programmed defaults. 

The IP address settings of the unit are remain 
unchanged and do NOT return to factory default. 

When the “Reconfig” button is released the 
firmware of the unit restarts with the factory 
default settings and enter normal operation 
automatically. 
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DADman control software 

The DADman control software runs on Windows or MAC-OSX computers. Once DADman is installed on 
your computer you can open the application. DADman controls the AX32 via Ehernet. Before you can 
operate one or more AX32 units the correct network configuration has to be applied. 

Assigning the IP address for the computer and the AX32 

When the DADman program is installed you are able to finalise the network configuration of the AX32 by 
connecting AX32 one by one. You have the option of using fixed IP addresses or IP addresses assigned via 
DHCP. 

Fixed IP address 

You must have a preferred range of IP addresses, and a network mask for the computer network and the 
connected AX32 units. 

Configure your computer IP address and network mask via the computer control panel to e.g. 10.0.7.25 | 
255.255.255.0 

Select the AX32 in the DADman Settings/ Device List menu by right clicking the unit line and select 
‘Network settings’ when using a Windows PC. On MAC-OSX you use the ‘Action’ button to select ‘Network 
Settings’. 

Configure via DADman each AX32 in turn with a unique IP address and the preferred network mask e.g. 
10.0.7.21 | 255.255.255.0. In this window you can also configure the IP audio network settings 

When you are done you can connect more than one AX32 to the network, and they will appear in the 
DADman Device List. 

Automatic  IP address 

You must have a network with a DHCP server which will allocate the IP addresses. 

Configure your computer IP address via the computer control panel to DHCP. 

Select the AX32 in the DADman Tools / Device List menu by right clicking the unit line and select ‘Network 
settings’. 

Configure via DADman each AX32 in turn to DCHP. 

When you are done you can connect more than one AX32 to the network, and they will appear in the 
DADman Device List. 

 

Figure 5, DADman Device list in Windows 



 

 

User Manual AX32  
 

Doc no. AX32-8002-A-4 Rev. date 140124 Page 13 of 31 

 

 
Figure 6, DADman Device list in 
MAC-OSX 

 

Top bar functions 

The top bar in DADman gives 
you access to the File menu 
and the Settings menu. On a 
MAC, there is also a DADman 
menu item. 

The File menu gives you 
access to save and load 
configuration files, i.e. when 
you have set up an AX32 as 
you want it, you can save the 
configuration so you can re-
load it later on if required. 

 

An important function is the Options menu under Settings (Windows) or Preferences menu under DADman 
(MAC). 
 

If the “Open last file at startup” is checked, DADman will automatically load the 
latest configuration file you used and download it to the AX32. This gives you a 
well-defined starting point in case other users have changed the configuration of 
the AX32. However, as more user can operate the AX32 simultaneously, it also 
means that you may disturb their work on the AX32. 

The GUI Layout lets you choose between three different colour schemes on 
DADman. 

Operation 

DADman is a channel strip oriented software showing all the units connected in the device list from left to 
right also including DAD AX24 converters which can be connected via USB. The units are shown in a 
sequence according the  unit ID number. Each unit will have a coloured  border surrounding the functions 
of the unit. 

The settings of an AX32 is always stored in the unit it self, so when connected DADman will show this 
status. A complete DADman preset can also be saved on the computer storing all setting and network 
configuration. DADman can be set to automatically load the preset when the program is started. If a preset 
is not loaded the connection to the AX32 units in the device list has to be re established when starting 
DADman. 

DADman can also be automated from various external sources. DADman can be connected via MIDI to Pro 
Tools emulation a Protools Pre, vi MIDI for a MIDI controller or via EuCon for interfacing to AVID/Euphonix 
consoles 

 

Please refer to appendix A for a guide to install the connection to Pro Tools Pre 
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The DADman windows are separated into the four functions: AD, DA, Connections and General as shown 
below. 

 

Most of the functions are quite intuitive. In the following section, the configuration and operation of the 
AX32 is explained in more details. 

Each subsection can be hidden by clicking on the      symbol. - 
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More AX32 units and also AX24 and NTP Penta 721units can be operated via DADman as well. 

Note that the order from left to right in which DADman shows the units are defined via 
the unit ID number which is stored in the units. The number can be changed by clicking 
the ID field in the corresponding section in the DADman window. 

The name of each unit can also be edited by clicking the name Window. This name is stored in the unit, and 
can be seen in the AX32 display.  

Also names for each analogue input and output channel can be assigned. This name is only stored in the 
DADman settings file and not in the AX32 unit. 

 

AD Section 

The AD section refers to the mic/line AD and line AD cards. If there are no AD cards in the AX32, the section 
will be blank. 

 

 

 

 

 

 

 

The screendump above shows the various settings in the AD section. 

The sliders for the MIC gain can be adjusted with the mouse or with the UP/DOWN and PAGE UP/DOWN 
keys. The mouse moves the gain setting in steps of 0.5 dB whereas the UP/DOWN keys move it in steps of 
0.1 dB. 

 

Mute 

MIC/LINE 
selection Phantom 

power 
ON/OFF 

Phase invert Mono/stereo 
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dB FS 
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MIC gain 
setting 

LINE 
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LINE 
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channel 
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DA Section 

The DA section refers to DA cards in the AX32. If there are no DA cards, the section will be blank. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The above screendump shows the DA section. 

Connections 

The setting in the DADman matrix is shown below  

The left side of the frame and 
the horizontal lines are the 
inputs, and top side and the 
vertical lines are the outputs. 
DADman will show the 
available inputs and outputs 
which will reflect the actual 
installed options and the 
number of channels available 
as a result of configuration and 
the actual sample rate of the 
AX32. 

The matrix consists of an 
overview matrix to the left and 
a detailed matrix, to the right, 
which appears when you select 
a cross point between two 

interfaces in the overview matrix. A cross point is set by clicking in the junction of the mono input and 

Mute 

Output level 

Mono/stereo 
selection 

Signal 
above -42 
dB FS 

Signal 
above -0.5 
dB FS 

Valid 
carrier 
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output channels you what to connect. Using ‘shift’ and mouse click you connect two consecutive channels. 
By using ‘control’ and mouse click you select a complete diagonal. Selecting the cross point again will 
disconnect the signals. A connection is marked by a blue square. 

The is some more helpful information available in the matrix view. In the top row  of the output signal 
names a blue square will be visible if the output is already connected. The square will be light blue if the 
output is connected to an input not shown in the detailed matrix. The square will be dark blue if the output 
is connected to an input shown in the detailed matrix. It is always possible to override this connection by 
just connecting to an other input.  

In the left side of the detailed matrix, there is a status indication next to each channel. These indicate: 

Green On a digital input, it indicates that there is a valid input and carrier. It does NOT indicate 
whether there is an audio signal in the channel. For an analogue channel, it indicates the card 
is present. 

Yellow Indicates sync loss or sample rate mismatch. 

Red Shows an error with the interface, typically no input signal. 

General 

The General section is divided into sub-sections such as Synchronization, ProTools HD interface, MADI Coax 
interface and Optical 1 and Optical 2 (if present). 

 

Synchronization 

The DADman settings for controlling the synchronization and sample rate are shown below: 

You can set the following parameters: Source, Sampling rate, Adapt to, 
Dante Rate, Word Clock Out and Sync termination. The following table 
shows which settings are available. Please note that DADman will only 
show the settings that are relevant in the given configuration. 

 

 

 

Parameter Options Description 

Source Internal, Word clock, AES 11, 
Video, AES/EBU 1-8, MADI Coax, 
MADI Opt. 1-2, Dante IP 

This determines the clock source 
of the AX32.  

Sampling 44.1 kHz, 48 kHz 

88.2 kHz, 96 kHz 

176.4 kHz, 192 kHz 

DSD 64 fs, DSD 128 fs 

DXD, 384 kHz 

This determines the sample rate 
of the AX32 if the “Adapt to” 
setting is set to Internal. If the 
“Adapt to” setting is set to any of 
the digital inputs, only the actual 
sample rate will be shown. 

Adapt to Internal, AES 11, AES/EBU 1-8, 
Pro Tools 1-2, MADI Coax, 
MADI Opt. 1-2, Dante IP 

The sample rate of the AX32 can 
either be set manually by 
selecting Internal, or it can follow 
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any of the digital inputs. For 
example, if it is set to Pro Tools 1, 
the sample rate will automatically 
follow the sample rate in your Pro 
Tools project. 

Out Word clock 

Word clock, base 

This parameter sets whether the 
Word Clock output should only 
follow the base sample rate (44.1 
kHz / 48 kHz) or follow the actual 
sample rate (44.1k / 48k / 88.2k / 
96k / 176.4k / 192k). 

Sync term. High Z 

75 ohm 

This parameter sets whether the 
Word Clock input is terminated 
internally in the AX32 with 75 
ohm, or left unterminated. It is 
strongly recommended that the 
Word Clock input is terminated in 
75 ohm for optimum 
performance. 

 

Pro Tools Interface 

The 2 Pro Tools interfaces can be configured as either 2 x Primary or as 
Primary/Extension. Furthermore they can be configured to emulate either 2 x HD-IO 
or HD-MADI, providing 32 channels in each interface. 

 

 

 

MADI Coax Interface 

The MADI Coax interface can be configured for compatibility with different 
implementations of MADI. 

Frame rate can be set to “Legacy” or “High”, but only if the sample rate is higher 
than 48 kHz. If the sample rate is 44.1 kHz or 48 kHz, the Frame rate is always 
Legacy. In Legacy mode, the MADI Frame length is maintained and adjacent 
channels are “merged” into one channel. In High mode, the MADI Frame length is 
reduced rate and consequently the Frame rate is increased. Because of this 
difference, the High mode has lower latency than the Legacy mode. Please note 

that some 3
rd
 party MADI products may not support High mode. 

Frame size can be set to “Normal” or “Extended”. Normal mode supports up to 56 channels whereas 
extended mode supports up to 64 channels. 

Ch. status can be set to “Default” or “Transparent”. The Ch. status setting is only relevant when routing 
incoming AES/EBU or MADI channels to a MADI output. In Default mode, the MADI Channel status bits are 
defined by the AX32, whereas in Transparent mode the channel status bits from the relevant source 
(AES/EBU or MADI) are transferred to the outgoing MADI signal. In most general cases it is best to leave it in 
Default mode. 

Input rate can be set to “Auto” or “As AD”. In Auto mode, the AX32 will try to determine the sample rate 
of the incoming MADI signal. In As AD mode, the AX32 will assume that the incoming MADI has the same 
sample rate as the AX32. It is usually recommend to leave this in Auto mode, however there may 
occasionally be compatibility issues with 3

rd
 party products. In that case, setting it to As AD may solve the 

problem. 
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Optical 1 / Optical 2 Interface 

The Optical MADI interfaces can be configured for 
compatibility with different implementations of MADI. 

Mode can be set to Disabled, MADI or NTP HotLink. The 
optical interface board can be fitted with one or two SFP 
optical interface modules. It is recommended to Disable the 
optical interface if no SFP optical module is installed. The MADI 
mode defines that the interface operates as a MADI signal. The 

NTP Hotlink mode is never used. 

Frame rate can be set to “Legacy” or “High”, but only if the sample rate is higher than 48 kHz. If the 
sample rate is 44.1 kHz or 48 kHz, the Frame rate is always Legacy. In Legacy mode, the MADI Frame length 
is maintained and adjacent channels are “merged” into one channel. In High mode, the MADI Frame length 
is reduced rate and consequently the Frame rate is increased. Because of this difference, the High mode has 
lower latency than the Legacy mode. Please note that some 3

rd
 party MADI products may not support High 

mode. 

Frame size can be set to “Normal” or “Extended”. Normal mode supports up to 56 channels whereas 
extended mode supports up to 64 channels. 

Ch. status can be set to “Default” or “Transparent”. The Ch. status setting is only relevant when routing 
incoming AES/EBU or MADI channels to a MADI output. In Default mode, the MADI Channel status bits are 
defined by the AX32, whereas in Transparent mode the channel status bits from the relevant source 
(AES/EBU or MADI) are transferred to the outgoing MADI signal. In most general cases it is best to leave it in 
Default mode. 

Input rate can be set to “Auto” or “As AD”. In Auto mode, the AX32 will try to determine the sample rate 
of the incoming MADI signal. In As AD mode, the AX32 will assume that the incoming MADI has the same 
sample rate as the AX32. It is usually recommend to leave this in Auto mode, however there may 
occasionally be compatibility issues with 3

rd
 party products. In that case, setting it to As AD may solve the 

problem. 
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Network fundamentals 

The following is a basic introduction to networks and how to set them up in relation to the AX32. Covering 
the entire subject of “network” would require several hundred pages so we will focus on the “need-to-
know” parts of it. 

What is a network? 

A network allows multiple devices, such as PC’s, printers and many others to communicate with each other. 
As opposed to traditional audio signals such as AES and MADI, which are point-to-point connections, a 
network allows any device on the network to communicate with any other device on the network. 

 

 

 

A network consists of one or more subnets. A subnet is typically a local network in building. A subnet can 
operate as a closed network with no external connections or it can be connected to the Internet. 

There are different types of devices in a network, e.g. PC’s, printers, AX32’s, switches and routers. 

The physical connection 

The devices in a network can be connected through a wide range of media. The most common for local 
connections is the UTP (Unshielded Twisted Pair) cable. This is also referred to as CAT5, CAT5e or CAT6. 
There are also other “CAT”-types, but the 3 mentioned here are the most common. The UTP cables are 
normally terminated in an RJ-45 connector. 

Other types of media can be fiber cables, wireless (Wi-Fi), coaxial cables and even power cables. 

As the AX32 and most computers have an RJ45 connector for use with UTP cables, we will focus on this 
type of interface. 

When using UTP cables, it is possible to use different bit rates, typically 10 Mbit/s, 100 Mbit/s or 1000 Mbit/s 
(1 Gb/s). The network interface on the AX32 and on most computers today support 1 Gb/s. It is therefore 
important that the cabling supports this bit rate to ensure a stable connection. Cat5 cables do NOT support 
gigabit transmission, so never use this type of cable. CAT5e and CAT6 cables both support 1 Gb/s, so make 
sure to use either of these two types. The CAT-type is usually printed on the cable, so it is easy to identify. 

CAT5e and CAT6 cables contain 4 twisted pairs, so  a total of 8 wires. In order to achieve gigabit 
transmission, all four pairs must be used. If only 2 pairs are used, the cable can only support 100 Mbit/s 
transmission. If you look closely at the RJ45 connector on a network cable, you can easily see whether 2 or 
4 pairs are used. 

Twisted pair cable like CAT5e and CAT6 comes in two main varieties, solid and stranded. Solid CAT5 cable 
supports longer length runs and works best in fixed wiring configurations like office buildings. Stranded 
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CAT5 and CAT6 cable, on the other hand, is more pliable and better suited for shorter-distance, movable 
cabling such as on-the-fly patch cabling. The maximum cable length for 1 Gb/s Ethernet is 100m when 
using solid cables, for both CAT5e and CAT6. NEVER assume you can go any further than that. 

Finally, network cables are available as either “straight” or “crossed” cables. This is a legacy from “old 
days” when connecting e.g. two PC’s directly to each other. Nowadays most network equipment 
automatically find out whether they should operate with “straight” or “crossed” connections and adapt to 
that, if necessary. 

 

SUMMARY 

1. Only use cat5e or cat6 cables. 

2. Make sure all 4 pairs in the cable are used. 

3. Make sure to use solid cables and not stranded cables for long cable runs. 

4. Never exceed 100m distance. 

 

Infrastructure 

There are different types of network devices which perform different functions. The main ones are a switch 
and a router. 

Switches are used for connecting local devices together. Switches have a number of ports, typically, 5, 8 16, 
24, 32 and upwards. Each port can connect to one device, so an 8-port switch allows you to interconnect 
e.g. 8 PC’s. Switches are generally non-intelligent so they simply provide a connection between the devices. 

Routers are used when a subnet needs to connect to another subnet or the Internet. Routers are intelligent 
and act as a “gateway” to other networks. They will handle all traffic that is destined for the “outside 
world” as well as take care of any traffic coming from the outside. Only one router is allowed in a network. 

Most routers nowadays also perform other functions such as firewall and DHCP-server (see later for more 
on DHCP). Most routers also have a built-in switch to make installations easier. 

 SUMMARY 

Switches are used for local connections between devices. 

Routers are used for connections to other networks. Routers are only required if the network has 
to connect to other networks or the Internet. 

 

Addressing 

As there can be many devices on a network, it is necessary that each of them has a unique address. This is 
called an IP (Internet Protocol) address and each device in a network must be assigned one. The IP address 
can either be provided automatically by a so-called DHCP-server or configured manually in the device as a 
fixed IP address. 

As mentioned earlier, most Internet routers have a built-in DHCP-server. When using a DHCP-server, a 
device is automatically assigned an IP address every time it is powered up or restarted. The DHCP-server 
ensures that no two devices get the same IP address. 

As the IP address is assigned to a device on power-up, it means the address can be different after a restart, 
as the DHCP-server simply assigns the device the first available IP-address. 

If the device on the other hand is configured with a fixed IP address, the IP address remains the same after a 
restart. It is perfectly legitimate to build a network where some devices have fixed IP addresses and other 
devices have DHCP-assigned IP addresses. However, it is important to ensure that no devices get the same IP 
address. If you have a device with a fixed IP-address, it is important that you ensure this IP-address does not 
interfere with other devices on the network. 

In addition to the IP address, the device must also have a “subnet mask”. The subnet mask helps the device 
identify which other devices are on the same subnet and which are on a different subnet. 
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Let’s have a look at how this works in real life, using an AX32 as an example. The following is a screenshot 
from the DADman software showing how to set the IP address of the AX32. 

 

 

 

On the left-hand side you will find the network settings of the AX32 itself. On the right-hand side you will 
find the network settings for the Dante Audio over IP module, if it is installed in the AX32. 

If you look at the AX32 settings, the first choice is between “Obtain an IP address automatically” or “Use 
the following IP address”. If you choose “Obtain an IP address automatically”, the AX32 will be assigned an 
IP address, Subnet mask and Default gateway automatically by a DHCP-server, if a DHCP-server is present 
on the network. 

If you instead choose “Use the following IP address” you must enter the IP address, Subnet mask and 
optionally Default gateway. 

“IP address” is obviously the IP address of the unit. 

“Subnet mask” is used to determine which devices are on the same subnet. Devices on the same subnet 
can communicate directly with each other whereas devices on different subnets can only communicate 
through a router. 

“Default gateway” is an optional parameter. Default gateway is the IP address of the router which would 
allow the AX32 to communicate with a device on another subnet. There is no need to provide a Default 
gateway if the AX32 does not need to communicate with devices on other subnets. 

So which IP address should you choose? If you use a DHCP-server, then it’s most likely already configured 
and you don’t need to worry about it. If you don’t have DHCP-server, you will need to choose IP addresses. 

IP addresses consist of 4 bytes (numbers), usually written with a decimal point between them, e.g. 
192.168.0.1. This means IP address can range from 0.0.0.0 to 255.255.255.255, giving a total of approx. 
4.3 billion addresses. The IP addresses are however reserved for different purposes, so for example some are 
public (i.e. used on the Internet) and other are private (i.e. only used on local networks). In order to avoid 
any problems, it is best to use the addresses reserved for private use, which are: 

10.0.0.0 to 10.255.255.255 

172.16.0.0 to 172.31.255.255 

192.168.0.0 to 192.168.255.255 

The subnet mask is necessary to identify which addresses are on the same subnet, and which are outside 
the subnet. A subnet mask of e.g. 255.255.255.0 means that all IP addresses where the first 3 numbers are 
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the same, are on the same subnet. For example, 192.168.0.5 is on the same subnet as 192.168.0.21 
because the first 3 numbers (192.168.0) are the same, whereas 192.168.1.10 is not on the same subnet as 
the 3

rd
 number is different. 

With a subnet mask of 255.255.255.0, there can be 256 devices on the same subnet, as the last number in 
the IP address goes from 0 to 255. If you need more than 256 devices on the same subnet, you can change 
the subnet mask to e.g. 255.255.254.0 which will give you an additional 256 devices, so a total of 512. 

Explaining how the subnet mask is used is rather complicated, so we recommend that you use 
255.255.255.0. 
 

 

SUMMARY 

IP address is the address of a device in a network. 

Subnet mask is used to identify which devices are on the same network and which are outside the 
network. 

Default gateway is the IP address of the router, in case a connection is required outside the local 
network. 
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Rear panel connections. 

 
Figure 4, Rear panel layout 

 

Rear panel layout 

1. Card slot 1 to card slot 8. 25 pole female D-sub connector with Tascam pin-out. Up to 6 pcs. 8-
channel analogue input or output cards can be installed. Slots 2 and 6 are currently not used. 

2. Mini module slot for dual optical MADI I/O via SFP. 

3. Power switch. 

4. Mains inlet. The same mains inlet is used even when a redundant power supply is installed. 

5. AES/EBU I/O channels 1-4. 25 pole female D-sub connector with Tascam pin-out. 

6. AES/EBU I/O channels 5-8. 25 pole female D-sub connector with Tascam pin-out. 

7. MADI I/O BNC connectors. 

8. DigiLink™ interface port for Pro Tools™ HDX, Primary port. 

9. DigiLink™ interface port for Pro Tools™ HDX, Primary port or Expansion port (configurable). 

10. Word Clock or Video Black Burst synchronization input (configurable), BNC connector. 

11. Word Clock synchronization output BNC connector. 

12. AES11/AES3 synchronization input, female XLR connector. 

13. Ethernet control and IP audio Primary port (net 1) RJ45 connector. Control port in redundant IP 
audio mode. 

14. Ethernet control and IP audio Secondary port (net 2) RJ45 connector 

15. Reconfigure button, and status LED 

 

Digital I/O Connections 

 Dual MADI SFP optical I/O mini-module 

 

The Dual SFP optical module, can be installed with one or two 
“Small form-factor pluggable” (SFP) transceiver modules. 

The SFP modules are standard types which support various types of 
optical interfaces with LED or Laser diodes, various wavelengths and 
fibertypes. Each SFP module has a receiver and a transmitter part, 
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and can be used for MADI audio I/O. 

The right part of the SFP connector is the receiver and the left part is 
the transmitter. 

 AES11 Sync input, Female XLR connector 

 

 

 

 

Pin 1.  TX. + 

Pin 2.  TX. – 

Pin 3.  RX. + 

 

Ethernet, RJ45 connector, Gigabit 

Pin 1.  BI_DA+ 

Pin 2.  BI_DA- 

Pin 3.  BI_DB+ 

Pin 4. BI_DC+ 

Pin 5.  BI_DC- 

Pin 6.  BI_DB- 

Pin 7. BI_DD+ 

Pin 8. BI_DD- 

 

AES/EBU I/O 25 pole female D-sub connectors 

The top connector provides the connection for AES/EBU I/O
channels 1-4. The lower connector provides the connection for 
AES/EBU I/O channels 5-8, providing a total of 8 AES/EBU I/O 
channels. 
Below is listed the connections for the combined input and output 
25 pole D-sub connector. The pinning is according to the 
proprietary standard by the company Tascam. 

 

Connections channel 1-4 / channel 5-8 

Pin no Func.  Pin no Func.  

1 DOUT 4/8 +  14 DOUT 4/8 -  

2 GND  15 DOUT 3/7 +  

3 DOUT 3/7 -  16 GND  

4 DOUT 2/6 +  17 DOUT 2/6 -  

5 GND  18 DOUT 1/5 +  

6 DOUT 1/5 -  19 GND  

7 DIN 4/8 +  20 DIN 4/8 -  

8 GND  21 DIN 3/7 +  

9 DIN 3/7 -  22 GND  

10 DIN 2/6 +  23 DIN 2/6 -  

11 GND  24 DIN 1/5 +  

12 DIN 1/5-  25 GND  

13 N.C.     

 

Pin out 
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Analogue I/O Connections 

Analogue I/O 25 pole female D-sub connectors. 

There are three types of optional analogue card for the AX32: 

• CARD-AX32-L8, 8 ch. Line AD Card 

• CARD-AX32-M8, 8 ch. Mic/Line AD Card 

• CARD-AX32-DA8, 8 ch. Line DA Card 

 
These are interfaced via a 25 pole D-sub connectors on the card 
which is accessible from the rear panel of the AX32 chassis.  

 

 

 

 

 

 

This connector type is used both for the analogue input card and for 
the analogue output card. 

Below is listed the connection for the 25 pole D-sub connector. The 
pinning is according to the proprietary standard by the company 
Tascam. 

For more a detailed description of the two cards please refer to the 
AX32 user manual. 

 

 

 

 

Connections channel 1-8 
 

Pin no Func.  Pin no Func.  

1 AIN/OUT 8 +  14 AIN/OUT 8 -  

2 GND  15 A/IN/OUT 7 +  

3 AIN/OUT 7 -  16 GND  

4 AIN/OUT 6 +  17 AIN/OUT 6 -  

5 GND  18 AIN/OUT 5 +  

6 AIN/OUT 5 -  19 GND  

7 AIN/OUT 4 +  20 AIN/OUT 4 -  

8 GND  21 AIN/OUT 3 +  

9 AIN/OUT 3 -  22 GND  

10 AIN/OUT 2 +  23 AIN/OUT 2 -  

11 GND  24 AIN/OUT 1 +  

12 AIN/OUT 1-  25 GND  

13 N.C.     

 

 

Pin out 
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Specifications 

Audio Specifications 

 Analogue input 

Sampling, resolution 5bit sigma/delta@5.645 or 6.144 MHz, 24 bit PCM  

PCM (DXD) sample rates 44,1, 48, 88.2, 96, 174.4, 192, 352.8, 384 kHz 

DSD sample rates 2.8224 & 5.6448 Mhz (64 & 128 fs) 

Dynamic range (A) > 123 dB 

THD+N(A) < -117 dB@-3dB FS / 0,00014% 

Cross talk < -120 dB 

Input Impedance (differential) > 10 k Ohm 

Max input level Adjustable from 9 dBu to 30 dBu in steps of 0.1 dB 

Microphone input gain range/accuracy Adjustable from -18 to +70 dB, in steps of 0.1 dB,  
± 0.25 dB accuracy 

Microphone equivalent input noise (A) < -133dB 

 

 Analogue output 

Modulator resolution, format 32 x oversampling, 1 bit DSD, 24 bit PCM  

PCM (DXD) sample rates 44,1, 48, 88.2, 96, 174.4, 192, 352.8, 384 kHz 

DSD sample rates 2.8224 & 5.6448 Mhz (64 & 128 fs) 

Dynamic range (A) > 128 dB 

THD+N(A) < -110 dB@-3dB FS 

Cross talk < -120 dB 

Max output level Adjustable from -60 dBu to 24 dBu in steps of 0.1 dB 

 

 Digital I/O and Synchronisation 

Digital I/O formats/ Supported sample rate AES/EBU, Pro Tools™  DigiLink™ , Dante™  IP Audio/up 
to 192 kHz.MADI / up to 384 kHz and DSD 

Synchronization/sample rate AES11, Word Clock, All digital inputs, Video Sync 
(word clock connector)/ PAL, NTSC, SECAM 

 

 Network Interface 

Interface 1000BASE-T, RJ45 connector, 4-pair connection 
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  Electrical Specifications 

 

Power consumption 90 VA max. 

Input voltage 90 – 260 VAC 

 100 – 240 VAC Nominal, 47 - 63 Hz 

Mains fuse, mounted in IEC connector 1 A, T1AH/250V 

Safety compliance EN 60950-1:2006 

 

Power supply cord must be min. light sheathed flexible cord according to IEC60227 (designation 60227 IEC 
52) and include a protective earth conductor having a green-and-yellow insulation. Cross-sectional areas 
min. 3x0.75mm2” 
 

Mains line plug type Correct type acc. to standard 
 

110-125V 
 

UL817 and CSA C22.2 no 42 
 

220-230V 
 

CEE 7 page VII, SR section 107-2-D1/IEC 83 
page C4. 
 

240V 

 

BS 1363 of 1984.Specification for 13A fused 
plugs and switched and unswitched socket 
outlets 

Mechanical specifications 

 

Chassis standard 19”, 2 RU 

Chassis depth, without connectors mounted 35.0 cm / 13.8” 

Chassis body width 43.5 cm / 17.2” 

Weight, not including I/O cards 5 kg / 11 lbs. 

 

 

Chassis air flow from front to rear 
 

 

 

Environmental specifications. 

Operating Temperature 0 – 45 ºC / 32 - 113ºF 

Humidity 

EMC compliance EN 55103-1, part 1: emission 

 EN 55103-2, part 2: Immunity 

 FCC 47 CFR part 15 (B): emission  
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Appendix A, guide to establish connection to a Pro Tools Pre 

This Appendix describes how to connect AX32 to Pro Tools to control the microphone preamps from within 
the Pro Tools environment (Mac) 
 

 

1. Preparation 
 
In the beginning you need to create 
two busses in the Audio-MIDI Setup’s 
IAC Driver.  
 
To access Audio-Midi-Setup you can 
either go in the Finder to 
Applications>Utilities>Audio Midi Setup, 
or you go in Pro Tools to 
Setup>MIDI>MIDI Studio.  
 
Once opened you have to click the 
MIDI-Devices tab. In this field you will 
find an icon named IAC-Driver. Double 
click and click More Information if 
needed. Now you should see the Ports 
panel. Add two new busses as in the 
picture. They both need just 1 MIDI In 
and 1 MIDI Out.  
 
After doing so, Save and quit Audio-
MIDI-Setup. 
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2. Settings in DADman 
Now launch DADman SW, go to 
Settings>MIDI Settings. In the little window 
choose Bus 1 as MIDI Input and Bus 2 as 
MIDI Output. MIDI Mode needs to be set to 
ProTools PRE. Click the little red button in 
the top right corner to close the window.  
 
Leave DADman running 

 
 

3. Settings in Pro Tools 
 
In Pro Tools you go to Setup>Peripherals and click the Mic Preamps tab. 
 

 
 
 
As Type you choose PRE from the popup menu for as many AX24s as connected. 
 

 
 
 
For the first 8 channels that the AX32 will Receive needs to be set to Predefined>IAC-Driver, Bus 
2>Channel-1. Continue for all other 8 channel groups of the AX32s with Predefined>IAC-Driver, Bus 
2>Channel-2 and so on. 
 
The Pre MIDI channels will correspond to 8 per 8 channel consecutive as they are listed in the DADman 
view. This actually covers any AX24 or AX32 input channel sequence. Set up in DADman. 
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For AX32 Sent To needs to be set to Predefined>IAC-Driver, Bus 1>Channel-1. Continue for all other AX32s 
with Predefined>IAC-Driver, Bus 1>Channel-2 and so on. Close the Peripherals dialog by clicking OK. 
 
Go to Setup>I/O Setup>Mic Preamps. 
 

 
 
Now click with the little pencil tool on the first channel where the AX24 is physically connected. 
 
Close the I/O Setup dialog by clicking OK. 
 
 

4. Controlling AX32 from within Pro Tools or from a control surface 
 
If you choose one of the hardware inputs with AX24 attached, Pro Tools will automatically call up the Mic 
Preamp control for that input. If it is not visible in Pro Tools@ Mix window, you need to go to View>Mix 
Window Views>Mic Preamps. All changes made here are reflected within DADman as far as they can 
controlled from Pro Tools. The controllable items are: 
 

• Mic and DI selects the microphone input setting in AX32, Line selects the line input setting. 
• The Fader has a range of 69 dB 
• -Pad moves the fader 18 dB down. In pad mode he level of the micpre can be adjusted in a range 

from -18 dB to +51 dB. 
• -Filter enables the high pass filter of AX24@s mic input 
• -48v enables the phantom power at the mic input. 
• -ø flips the phase of the mic input by 180°. 
• -Insert has no effect 


